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Installation Instructions for JMPS Versions JMPS Combat1 (JC1) and JMPS Combat Planning (JCP) 

1 Overview

This document describes how to install the Joint Mission Planning System (JMPS) versions JC1 or JCP on a Common Operating Environment (COE) configured Personal Computer (PC).  (For developers installing in a non-COE environment, differences have been noted in the document.) As a convention, when JC1/JCP is written, it implies that JC1 and JCP are interchangeable in the instructions.  JMPS installations consist of configuring your PC for the JMPS installation and then installing and configuring the JMPS software.

To install JC1/JCP:

· Verify prerequisites – Verify the hardware prerequisites and configure your system with the software listed in section 2 - Set up JMPS Environment Set up JMPS Environment. 

· If you have any previous version of JMPS installed (JC1, JCP, or JV1), uninstall it (see section 3 - Uninstall Previous Versions of JMPS).  You may not have more than one version of JMPS installed on a machine. 

· Complete the steps in the Pre Setup section to configure the system for JMPS (see section 4 - Pre Setup).

· Copy the JMPS install package to your hard disk.  (Some machines have a security feature restricting the install from CD for COE, and installing over a network may time out or get interrupted, resulting in errors). 

· Install JMPS (see section 5 - Installation)

· Complete the steps in the Post Setup section (see section 6 - Post Setup).

This document is divided into the following sections:

1  Overview – An overview of the process and document


2  Set up JMPS Environment – Hardware and software required to run JMPS


3  Uninstall Previous Versions of  JMPS – Uninstall old software


4  Pre Setup – Configure machine for JMPS 


5  Installation – Install JMPS and the Mission Binder Repository


6  Post Setup – Configure application settings


7  Detailed Instructions – More detailed instructions for selected steps


8  Trouble Shooting – Solutions for selected error messages

2 Set up JMPS Environment

Setting up the JMPS environment consists of verifying that your PC contains the prerequisite hardware and software and then setting up the PC for the installation.  Prerequisite software includes the Windows 2000 Operating System and the applicable COE segments.  Following the installation of the Operating System, several system and security administrator functions should be completed.  These functions include performance tuning, disk partitioning, establishing local accounts, enabling security event logging, and setting system and JMPS roles and privileges. 

It is recommended that the PC be configured to improve performance.  A fragmented area (i.e., file, folder, registry) is split up into many pieces and scattered over a volume. When a volume contains a lot of fragmented files and folders, Windows takes longer to gain access to files/folders because several additional disk drive reads are required to collect the various pieces. Creating new files and folders also takes longer because the free space available on the volume is scattered. Windows must then save new files and folders to various locations on the volume. To minimize these performance variables, the Swap Size is adjusted and the disk, including the swap disk, paging files, and registry is defragmented.  To get the best and most consistent performance for testing and to eliminate unknowns, the following are performed as part of the basic configuration:  

· Set the swap size to a fixed size so that the min and max size are the same. This prevents fragmenting.  Microsoft recommends this be at least twice the amount of real RAM that is on the machine.  The minimum recommended swap size is 512MB (most machines have 256MB of physical memory installed.)

· Reboot the system and defragment the drives using the default defragmentation tool that is installed with Windows 2000.

· Reboot the system and run PageDefrag (pagedfrg.exe) and select “Defragment paging files and Registry at next boot”. This free third-party tool defragments the paging and registry files and is available at http://www.sysinternals.com. Reboot the system for the tool to perform the defragmentation process.

COE Integration and Run-Time Specification (I&RTS) 4.1 recommends that NT-based COE platforms have a minimum of three disk partitions.  The recommended install of COE would have the following partitions at a minimum (one partition is fine for non-COE installs):

· System drive - reserved for the operating system files and core components. (The system drive is also referred to as the primary partition.)

· Segment drive - reserved for mission-application segments.

· Data drive - reserved for:

· User and group file storage

· Segment dynamic data files

· Database segments.

For JMPS, it is recommended that the administrator set the drive partition sizes during the setup of the machines.  The drives will be partitioned as:

· C drive containing the Operating System (The drive with the COE kernel is read-only.)

· D drive containing Programs (MS Office, Norton AntiVirus, Acrobat Adobe, JMPS Software)

· E drive containing Data  (JMPS Data)

The size of each partition may vary depending on the drives capacity. 

Prior to the establishment of the system security configuration, the required COE segments (see section 2.2 - JMPS Software Configuration) must be installed.  

During installation, critical system security policies are automatically established to reduce system vulnerabilities.  Authorized administrators are provided with training and procedural documentation with regard to installation, configuration, implementation, and security lockdowns. Proper installation ensures that the functional data is secured.  Guidance on establishing security configuration and performing system lockdown is provided in the Trusted Facility Manual (TFM) (JV1-448-01002, JMPS Version 1.0, Appendix L - TFM Final, 21 June 2002).

To enable the Security Event Log, use the Control Panel\Local Security Policy\ Local Policies\ Audit Policy function to enable audits.  For JMPS, it is highly recommended that the security and application event logs be set to overwrite, as the log tends to fill up quickly which causes the JMPS application to terminate.  It is recommended that other event logs (e.g., system) be set to overwrite, as well.
JMPS will check that users have particular roles to perform particular functions within JMPS.  To be able to Run JMPS, a user must have at least one of the 4 unique JMPS roles (described below).  There are also some functions within JMPS that require a specific privilege (described below).  Both Role checks and Privilege checks are performed using Windows Groups.  The Windows System Administrator (SA) is authorized to install and de-install executables, including new or revised versions or patches to the current operating system.  The Windows SA performs the initial JMPS installation and establishes the JMPS Security Administrator role and accounts.  The JMPS Security Administrator is responsible for establishing all the other JMPS roles, privileges, and accounts. The System Administrator must set up Windows Groups for all Roles and Privileges defined for JMPS, either on the domain or on the local machine.   Because the Mission Planner role is checked first during JMPS startup, it is recommended that all users be added to this group to minimize the additional startup time when using local groups.

JMPS Roles:

· JMPSAdministrator - Authorized to set group preferences, and establish other system configuration settings that are not security related.

· JMPSDatabaseAdministrator - Authorized to load specific data items as specified in the JMPS Security Target (ST), including DAFIF, Aimpoints, NIMA Map products, and Threat Data.

· JMPSSecurityAdministrator - Authorized to perform all security related operations including audit data management and audit and logon monitoring.

· JMPSMissionPlanner - Authorized to perform all JMPS operations which are not otherwise restricted to the above roles.

JMPS Privileges:

· JMPSDowngradePrintedOutputClassification - Authorized to modify the classification for printed output material.

· JMPSCollaboration - Authorized to mission plan in collaboration mode.

Following the establishment of the JMPS Roles and Privileges, it is recommended that the JMPS Security Administrator limit permissions and access to the JMPS data.  This is accomplished by removing access to JMPS files to the Authenticated User Windows Group (Windows default setting) and granting access to these files to specific JMPS Roles (e.g., access to security related files is limited to the JMPS Security Administrator role).  Detailed procedural guidance on performing this action is provided in section 3.5 of the JMPS TFM (JV1-448-01002, JMPS Version 1.0, Appendix L - TFM Final, 21 June 2002).  These procedures have been developed around the Microsoft Management Console (MMC) utility provided with Windows 2000 and the JMPS-files.inf file provided with the JMPS installation.

2.1 JMPS Hardware Configuration

The minimum hardware required to install and run JMPS is listed in Table 2‑1 Minimum Hardware Suite for JMPS Version .  This is broken down into functionality when the requirements are different for a particular functionality.

Table 2‑1 Minimum Hardware Suite for JMPS Version JC1/JCP

To support Backup/Restore of Mission Binders and Standalone Export/Import the minimum configurations for each type of media storage to be used is as follows:

	Media Storage Type

	Minimum Configuration

	CD/RW
	24 x 10 x 40, Access Speed 110ms

Transfer Speed 6.0 MB/sec

	Zip Disk Drive
	Internal Zip® 100MB ATAPI drive

	Tape Drives
	2 MB/sec data transfer rate (native)


To support Server, the minimum configurations are as follows:

	Feature
	Minimum Configuration

	Processor
	Single Intel Pentium IV 1.40 GHz Processor 

	Level 2 Cache
	512 KB 

	RAM
	1 GB, PC133-MHz SDRAM

	Network Interface Card
	PCI 10/100 MB/sec

	Hard Drive 
	One 60 GB 7,200 rpm Drive.

	OS
	Windows 2000 Advanced Server 

	COE
	Version 4.6 


To support all JC1/JCP functionality, the minimum configuration is as follows:

	Feature
	Minimum Configuration

	Footprint
	Laptop or Desktop

	Processor
	Single Intel Pentium III 1.20 GHz Processor 

	Level 2 Cache
	512 KB 

	RAM
	512 MB, PC133-MHz SDRAM

	Network Interface Card
	10/100 MB/sec

	Hard Drive 
	One 40 GB 7,200 rpm Drive.

	Video Card 
	32MB, 4XAGP, supports OpenGL

	OS
	Windows 2000 Professional or Windows 2000 Server or Windows 2000 Advanced Server

	COE
	Version 4.6


2.2     JMPS Software Configuration

JMPS is targeted to run in a COE environment.  The purpose of the COE Kernel software is to provide a common base environment for related kernel, account group, and other software segments. It is a foundation for building an open system architecture that is not tied to a specific platform. The COE Kernel includes both government off-the-shelf packages and commercial off-the-shelf software. This version of JMPS requires the Microsoft Windows 2000 Operating System, the COE Kernel, and the COE Segments listed in the COE Prerequisite Segments section of the table below.  These segments are installed with the COE installer. 

To set up a JMPS server, note the differences highlighted in the table. (Windows 2000 Server is sufficient for small development networks). Also on the server, you may choose to setup a File Transfer Protocol (FTP) server (see section 7.2 - Install and Configure the FTP Server) for JMPS PTW server functions.

After the system Software and the COE Prerequisite Segments are installed, the JC1/JCP software listed in the JMPS Software section are installed (see section 5- Installation (JMPS and Mission Binders)).

For developers who chose to install in a non-COE environment, see the software listed in the Non-COE Configuration below and register the JMPS Security stub (JmpsSecurityUtilitiesStub.dll).  

Table 2‑2 COE Configuration Software

	Segment or Software Name
	Segment Prefix
	Version #
	Software Media Source
	Required/

Optional

	System Software

	Microsoft Windows 2000 Professional operating system (for client or standalone machines) with Service Pack 3, or Windows 2000 Advanced Server (for JMPS Servers) 

	
	2000 Pro

2000 Adv Srv
	Microsoft CDs
	Required

	DII COE Kernel
	
	4.2.0.5
	DISA COE CDs
	Required

	DII COE Kernel 4.2 Patch
	K42PX
	4.2.0.0P8
	DISA COE CDs
	Required

	W2K Patch Update
	W2KPTH
	4.6.0.0/SP3-128bit
	DISA COE CDs
	Required

	File Transfer Protocol (FTP)
	
	
	Microsoft CDs
	Required for PTW*1

	MS Message Queuing Service (MSMQ)  (see section 7.4)
	
	
	Microsoft CDs
	Required for Collaboration

	COE Prerequisite Segments

	Adobe Acrobat Reader
	ACRORD
	4.5.1.0
	DISA COE CDs
	Optional

	COE Update System Security Level
	UPDTSL
	4.6.0.0
	DISA COE CDs
	Required

	COE Security Banner
	SECBNR
	4.6.0.0
	DISA COE CDs
	Required

	Java Platform 2
	JAVA2
	4.7.0.0
	DISA COE CDs
	Required

	J2SE JRE 1.4 (Includes Java Web Start)
	J2JRE
	4.7.0.0
	DISA COE CDs
	Required

	JMTK Utilities Segment
	JMU
	4.6.0.1
	DISA COE CDs
	Required

	MS Office 2000 Professional
	OFFICE
	4.6.0.0
	DISA COE CDs
	Required

	MS Security Config Templates
	W2KCET
	4.6.0.1
	DISA COE CDs
	Required

	MS SQL Server 2K Enterprise Edition (for JMPS Server)
	4.4.0.1
	SQL2KE
	DISA COE CDs
	Optional *2

	Norton Anti Virus
	NAV
	4.5.3.0
	DISA COE CDs
	Required

	Netscape Web Browser
	NSWEB
	4.7.0.0
	DISA COE CDs
	Optional

	PERL
	PERL
	1.0.0.4/5.005_3
	DISA COE CDs
	Required

	Online Docs
	ONDOC
	4.2.0.0
	DISA COE CDs
	Optional

	JMPS Software

	MissionBinderRepository_1-0-0-6
	
	1.0.0.6
	JMPS CD
	Required for Mission Binders

	JMPS MSI Install
	
	Current Build
	JMPS CD
	Required

	JMPS-Framework abbreviated segment
	
	Current Build
	JMPS CD
	Optional

	JMPS-Framework-Data abbreviated segment
	
	Current Build
	JMPS CD
	Optional

	Microsoft Desktop Engine (MSDE)
	
	2000SP3
	JMPS CD
	Required *3

	VBScript 5.6 Patch
	
	5.6
	JMPS CD
	Required *4

	PTWProtocolData.xml (secret file)
	
	
	PMA-233
	Optional *5


*1 For machines hosting the Precision Targeting Workstation (PTW) FTP Server.  Typically the JMPS server.

*2 For production or larger networks MS SQL server is suggested over Microsoft Desktop Engine (MSDE).

*3 Required if MS SQL server is not installed.  It will be installed by the JMPS Installer.

*4 A VBScript 5.6 executable will be copied to the hard drive during the JMPS install.  If, while installing JMPS, you get the following message “The version of VBScript installed on this machine appears to be lower than the version required by JMPS”, then navigate to the Program Files/JMPS/Setup/Scripts/scripten.exe.  Run the scripten.exe by double clicking on it.  (If you did not install to the default Program Files folder, navigate to your selected install folder).

*5 PTWProtocolData.xml (secret file).  The secret PTWProtocolData.xml file provides the capability to filter PTW imagery data on one additional piece of Meta-data.  To obtain this file, please contact Jocelyn Alston at the PMA-233 program office. AlstonJM@navair.navy.mil .  When you receive this file, replace your existing PTWProtocolData.xml file, located in the dataInstallDir\DATA\local\JMPS\data\PTWData with the new one.

Table 2‑3 Non-COE Configuration Software

	Prerequisite Software
	Required/

Optional

	Microsoft Windows 2000 Professional operating system with Service Pack 3 (for client or standalone machines) or 

Windows 2000 Server or Windows 2000 Advanced Server (for JMPS Server)
	Required

	Microsoft Office 2000 with Service Release 2 (To verify you have MS Word Patch 2 installed, launch Word and select About Microsoft Word from the Help menu. Verify it says Microsoft Word 2000 (9.0.4402SR-1).
	Required

	ActivePerl 5.6.1
	Required for Weather

	Joint Mapping Tool Kit Utilities (JMU 4.5 - SDK)
	Required

	Web Browser with 128-bit encryption
	Required

	Java WebStart (for SPF access)
	Optional

	JDK 1.4.1_02 The Java Development Kit
	Required for Mission Binders

	Microsoft Message Queuing (MSMQ) (see section 7.4)
	Required for Collaboration

	MissionBinderRepository_1-0-0-6
	Required for Mission Binders

	JMPS MSI Install (JC1– buildno, or JCP – buildno)
	Required

	Microsoft Desktop Engine (MSDE) This is installed by the JC1/JCP Install if a version of MSDE is not already installed and named machinename/JMPS_SQL_Server)
	Required

	VBScript 5.6 Patch
	Required


3 Uninstall Previous Versions of JMPS

Only one version of JMPS (JC1, JCP, JV1) may be installed at a time. If you have any version of JMPS installed, you must uninstall it before installing the new version. 

If you have an earlier version of JC1 than JC1 0.2 installed, you must un-attach the SQL databases manually before uninstalling/installing JC1/JCP, by running the DB Maintenance tool located in the Start->Programs->JMPS Admin menu and selecting the Detach DB tab.  This is done automatically for you in versions of JC1 0.2 or higher and all versions of JCP.

If you have an earlier version of MSDE than SP3, please uninstall it.  

If you have the WXI (weather) Task Scheduler running, you must stop it manually before uninstalling Combat1.  The WXI Task Scheduler, if running, shows up in the Task Bar as a Cloud.  This is normally in the lower right hand side of the screen.  To stop the WXI Task Scheduler, Right Click on it and Select “Terminate WXI Task Scheduler”.

The following steps uninstall JC1/JCP:

1. Log on as machine administrator.

2. Go to your Start menu.  Select Settings\Control Panels\Add Remove Programs.

3. Un-install each of the following in this order:
· Combat1-Data

· Combat1

· JMPS-Combat1-Data

· JMPS-Combat1

· MissionBinderRepository - COM+ Component 
· JMPSUPDataServer – COM+ Component

· JMPS-Framework - abbreviated COE segment for JMPS

· JMPS-Framework-Data - abbreviated COE segment for JMPS
4 Pre Setup

4. Ensure you have the prerequisites installed (see Section 2 - Set up JMPS Environment). (To verify you have MS Word Patch 2 installed, launch Word and select About Microsoft Word from the Help menu. Verify it says Microsoft Word 2000 (9.0.4402SR-1).  Ensure that an Office product, such as Word, has been run on the machine at least once.
5. If you are not going to apply the security lockdowns during the install, then set the Event Viewer logs to “Overwrite events as needed”. This step is not required for a JC1/JCP install with security lockdowns applied. Those are included in the security templates applied during the install.

· Right-click on My Computer and select Manage.

· Expand the Event Viewer by clicking the +.

· Right-click on Application and select Properties.

· In the Log Size section select Overwrite Events as needed.

· Click OK.

· Repeat for the Security and System logs.

6. Roaming Profiles - For those machines that are domain controllers, you may optionally elect to set up Roaming Profiles. When using roaming user profiles, users can log on to any computer that is running Windows 2000 within the user's domain. After they log on, all of the user settings and documents they stored on the server in the roaming user profile copy to the local computer. Users can run applications, modify documents, and work on the computer as they normally would until they log off. When a user logs off, the user profile is copied to a server. When the user logs on to another computer, all of that user's profile information is copied to the second computer.

· If there isn’t a shared folder set up for roaming profiles on the domain controller, then create one.

· To create a shared folder, go to the drive on the server where you want the folder to be created using Windows Explorer.  In the File menu go to New and select Folder.

· Type in a name such as “RoamingProfiles” for the new folder’s name.

· Right-click on this folder and select Sharing…

· Select the Share this folder option and make note of the Share name (Share name).  

· Click OK.

· Now click on the Start menu, go to Settings, and select Control Panel.

· Double-click on Administrative Tools.

· Double-click on Active Directory Users and Groups.

· Double-click on the user you want to set up a roaming profile for.

· Click on the Profile tab.

· In the Profile Path field type “\\<servername>\Share name\user name”, then click OK.

· Close the Active Directory Users and Groups window.

· If your user was logged in one of the workstations during this process, then you must log out of that workstation and log back in.

7. For those machines that will host the Precision Targeting Workstation - FTP server (This will probably the JMPS Server), set up and configure an FTP server (see section 7.2 - Install and Configure the FTP Server).

8. If the permission have not already been set after installing the DII COE segments and applying the COE security lockdowns (W2KCET), then you need to do the following. (This only needs to be done once on a machine, not with every JMPS install.)

· Modify the Domain Security Policy to allow Administrators to log on as a service on the Domain Controller.

· Modify the Domain Controller Security Policy to allow Administrators to log on as a service on the Domain Controller. (May need restart the SQL Server service.)

· Modify the Local Security Policy to allow Administrators to log on as a service on the JMPS servers. (May need to restart the SQL Server service.)

5 Installation (JMPS and Mission Binders)

5.1 Install JMPS Versions JC1/JCP

You will first install the program (in two parts and with two COM + components) and then the data (in two parts) (see Table 7‑1 for detailed instructions).  If you are installing on a COE machine, after the JMPS install, install the two JMPS abbreviated segments. If you are installing from CD and get an error message saying “Error Cannot find Data.cab”, then copy the install file to your hard disk and install from there.  Some machines have a security feature restricting the install from CD usually for COE.  The JC1/JCP install will also install MSDE with SP3, if a version of MSDE is not already installed.  If you have an earlier version of MSDE, please make sure it is uninstalled before installing JMPS, and MSDE will be reinstalled automatically.  If you have a version named machinename/JMPS_SQL_Server, the JC1/JCP install will use it.  

Please note that there is a problem if you need to uninstall MSDE 2000 SP3.  The database files are not removed during uninstall.   If you ever need to uninstall the MSDE 2000 SP3, then you will need to delete the files in the following folder before you reinstall MSDE 2000 SP3: $DataDir\MSSQL$JMPS_SQL_SERVER\Data\.  These files should only be deleted after you have uninstalled MSDE 2000 SP3 (JMPS_SQL_SERVER) because they are MSDE's system database files!  If you do not delete these files, the JC1 install will fail during the install of MSDE.

To install JC1or JCP:

· Log in as a machine administrator.

· Copy the Build JC1/JCP-buildno folder to your hard drive.

· Navigate to Build JC1/JCP-buildno/JMPS and select setup.exe.  

· Select Next to start the Program Install.

· Select the I accept the terms in the license agreement radio button and click Next.

· Click Next to accept the defaults, or select Custom to assign the drive you are installing to. (If you are installing on a machine with a D hard drive, this will be the program default drive as recommended by COE.  Otherwise it will be the boot drive.)

· On the Client vs. Server screen, select the radio button associated with client, if you are installing on a client machine.  Select the radio button associated with server, if you are installing on a machine that will function as a JMPS data server and/or domain controller. Click Next to continue with the install.

· On the COE Security Settings screen, select the Yes radio button, if you want the COE/JMPS security policies installed. (This is permanent and will not be removed by un-installing JMPS.  It will lock down the machine).  Select the No radio button, if you do not want to apply the COE/JMPS security settings. Click Next to continue with the install.

· Click Install, to start the Install.

· Click Finish, to finish the JC1/JCP Program Install and automatically start the Data install.

· Click Next, to start the Data Install.

· Click Next to accept the defaults, or select custom to assign the drive you are installing to
. (If you are installing on a machine with an E hard drive, this should be the Data default drive as recommended by COE, otherwise it will be the boot drive.) 

· Click Install, to start the Install.

· If you do not have MSDE installed and named machinename/JMPS_SQL_Server, then at the end of the data install, MSDE with SP3 will be installed. If MSDE is installed, click continue to the any/all dialogs titled “Digital Signature Not Found” to continue with the install.

· Click Finish, when the Completing the JMPS-Combat1-data Setup screen appears.

On COE machines, install the two JMPS abbreviated segments – JMPS-Framework and JMPS-Framework-Data Segment. (This is currently optional and will put segment information on COE machines as well as updates COE lockdown settings.  These updates include: Allow the JMPS Users to run MMC and see the Event Viewer logs, Allow JMPS users to schedule tasks in the Task Scheduler (GPS Almanac Auto Update), Modify permissions on JMPS files and directories).  To install the segments:

· Click on the Start menu, go to Programs, DII Applications, SysAdm, and select Segment Installer.

· Enter “the COE installer password” for the password (if it asks for a password).

· Click on the File menu and select Select Source drive.

· Select the location of the segment files (usually JC1 <build no>\JC1\JMPS Segments, or JC1\JMPS Segments), then click OK.

· Click on the File menu and select Read Table of Contents.

· Check the JMPS-Framework and JMPS-Framework-Data segments.

· Click on the Available Software menu and select Install.

· Restart the machine after the install is finished.

The JMPS databases should have been attached during the JC1 install.  You can manage the attaching and detaching of databases using the DB Maintenance tool installed with JMPS.  This can be accessed through the Start->Programs->JMPS Admin->DB Maintenance menu. If there has been a problem with attaching the databases, please use the DB Maintenance tool to attach and detach the databases. The following is a list of JMPS databases that are attached during the install:

· Aimpoints

· DAFIF

· JTIDS

· LocalPoints

· OrderOfBattle

· PointExport

· ThreatParameters

If you have problems with MSDE, then you may uninstall it via the Add/Remove Control Panel and re-install it using the MsdeInstallTool.exe located in the drive:\Program Files\JMPS\setup\MSDE folder.  If you get an error message stating unable to attach to multiple databases, determine if any of the above databases were not attached.  If one was not attached, navigate to the database and delete the databasename_log.ldf file associated with it. The databases are located in the InstallDir\data\local\jmps\data\databasename directory.

5.2 Install Mission Binders 

If you are installing the MissionBinderRepository_1.0.0.6 COE segment (COE environment), install via the COE Installer, otherwise install as described below in the NON-COE MissionBinder Install section.

COE MissionBinder Install – Install the Mission Binders Repository program portion to the Programs partition (nominally the D: drive) and the Data portion to the Data partition (nominally the E: drive)

· Click on the Start menu, go to Programs, DII Applications, SysAdm, and select Segment Installer.

· Enter “the COE installer password” for the password (if it asks for a password).

· Click on the File menu and select Select Source drive.

· Select the location of the segment files, then click OK.

· Click on the File menu and select Read Table of Contents.

· Check the Mission Binders segment.

· Click on the Available Software menu and select Install.

· On the Introduction screen click Next.

· On the Choose Install Folder screen change the folder path to D:\Program Files\MissionBinder, then click Next.

· On the Choose a Folder screen change the folder path to E:\data\local\MissionBinder, then click Next.

· On the Pre-Installation Summary screen click Install.

· Wait for the installation to finish, then on the Install Complete screen click Done.

· Click Yes when it asks if you wish to reboot now.

NON-COE MissionBinder Install

· Log in as a machine administrator.

· Navigate to the MissionBinderRepository_1-0-0-4\Windows directory.

· Double-click “setup.exe”.

· “Install Anywhere” will appear in the Mission Binder window.

· Click the “Next” button.

· The “Where would you like to install?” prompt will appear.

· The default value for this prompt is usually fine.  (However, if you are installing on a COE machine, install to the appropriate drive for program executables.  This will probably be the D drive.)

· Click the “Next” button.

· The “Choose a folder to store Mission Binder data files” prompt will appear.

· You probably will want to change the location to a data directory, such as “drive:\data\local\MissionBinder\data”. Remember this path, you will need it to attach the database later.  (If you are installing on a COE machine, select install to the appropriate drive for data, nominally the E drive.) 

· Click the “Next” button.

· Click the “Install” button.

· The Mission Binder Repository will now be installed.

· When the installation completes, click the “Done” button.

· When the “Install was successful” message appears, select the “OK” button.

· Reboot the computer.

To use Mission Binders, you must attach the MissionBinder database.  You may use the DB Maintenance tool installed with JC1.  This can be accessed through the Start->Programs->JMPS Admin->DB Maintenance menu.  Select the Attach DB tab, then select the Browse button and browse to the MissionBinder.MDF file located in the location you installed the MissionBinder data.  Then click the Attach Database button.

6 Post Setup

1. Security Stub: If you are not running on a COE machine (UPC Developers), you must register the developer’s security stub, JmpsSecurityUtilitiesStub.dll.  This is available on the China Lake site under UPC Devlopers/ToolsTestbed/Developer Security and Privilege stubs.  Do not register the Privilege stub for JC1 or JCP versions of JMPS.

2. JMPS Server: For those machines running as a JMPS server, configure the JMPSPublisher COM+ service to run as an administrative user.  (Developers may choose to skip this step if they will always be running with Administrator privileges, but some client/server functionality may not be available).  

· Right-click on My Computer and select Manage

· In the left windowpane, expand Services and Applications

· In the left windowpane, click on Services

· In the right windowpane, right-click on JMPSPublisher and select Properties

· Change the Startup type to Automatic

· Click on the Log On tab

· Select “This account”

· Browse to the local “administrator” user.  Type in the administrator password.

· Click on the OK button

· In the right windowpane, right-click on JMPSPublisher and select Start.

· Close the Computer Management window.

· Log off the machine.
3. Configure the JMPSUPDataServer:  Configure the JMPSUPDataServer COM+ application to run as an administrative user:  (Developers may choose to skip this step if they will always be running with Administrator privileges).
· Click on the Start menu, go to Settings, select Control Panel.

· Double-click on Administrative Tools.

· Double-click on Component Services.

· Expand Component Services by clicking the +.

· Expand Computers by clicking the +.

· Expand My Computer by clicking the +.

· Select the COM+ Applications folder.

· In the right window pane right-click on JMPSUpDataServer and select Properties.

· Click on the Identity tab.

· Select the This user: radio button.

· Click on the Browse… button.

· Select the local administrator.  (If you’re on the domain controller, use the domain administrator instead.)

· Enter “the administrator password” for the password fields.

· Click on the OK button.

4. PTW Server:  On hosts that will function as the JMPS PTW Server (typically the JMPS Server), configure the PTW Server. To receive data from the PTW server, you must point to a folder where the PTW information is to be put, and tell the PTW process where this folder is. You created this folder when you setup your FTP server for PTW in the Pre-Setup section. (i.e. C:\inetpub\ftproot). Edit the registry value located in HKLM\Software\JMPS\PTW\FtpPushPath and set it to the newly created folder.   To enable the PTW Service on the Server, Right-Click on My Computer and Select Manage.  Expand the Services and Applications Tree in the Computer Management Dialog.  Select the Services entry.  In the right-hand window, Right-Click on the PTW Service and Select Properties.  In the PTW Service Properties Dialog, Select the Log On tab.  Under the Log on as: section, Select the This account radio button.  Browse to a domain administrative user.  Type in the Password for that user in the Password and Confirm Password text boxes.  Click Apply and then OK.

5. Configuring Email Notification:  A new procedure for configuring JMPSAdministrator to receive Email notification upon specific JMPS Errors is in place.  Place the email address of the selected administrator in the Registry in the HKEY_LOCAL_MACHINE\Software\JMPS\AlertAdminEmailAddress field. (See section 7.3- Configuring JMPSAdministrator Email Notification)

6. Configure GCCS-M/I3: A JMPS client can be configured so that it can communicate with GCCS-M/I3 DAL to import Order of Battle data. (See section 7.6 - Setup GCCS-M/I3 DAL).

7. Domain Controller Active Directory:  Set up and configure Active Directory, for those machines that are running as a Domain Controller (see section 7.5 - Configure Active Directory).

8. 
Security Lockdowns, Policy Settings on Domain Controller and JMPS domain: If you are working in a domain environment and want to be Locked-Downed as an Operation environment, after installing JMPS with Security Lockdowns applied, then Apply Domain Controller and Domain Level Security Lockdowns on the Domain Controller.
).

· On the domain controller, log in as the administrator 

· Click on the Start menu, go to Settings, select Control Panel.

· Double-click on Administrative Tools.

· Double-click on Domain Controller Security Policy.

· Right-click on Security Settings and select Import Policy.

· Select JMPS.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Right-click on Security Settings and select Import Policy.

· Select CoeJMPSBasicAuditPolicy.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Right-click on Security Settings and select Import Policy.

· Select CoeJMPSSecurityPolicy.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Right-click on Security Settings and select Import Policy.

· Select JMPS_files.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Close the Domain Controller Security Policy window.

· Double-click on Domain Security Policy.

· Right-click on Security Settings and select Import Policy.

· Select JMPS.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Right-click on Security Settings and select Import Policy.

· Select CoeJMPSBasicAuditPolicy.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Right-click on Security Settings and select Import Policy.

· Select CoeJMPSSecurityPolicy.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Right-click on Security Settings and select Import Policy.

· Select JMPS_files.inf and click on Open.

· Right-click on Security Settings and select Reload.

· Close the Domain Security Policy window.

· Close the Administrative Tools window.

· Restart the machine.

9. Security Lockdowns, User Rights Assignment on JMPS domain: Each of JMPS groups will be allocated specific operating system level privileges to perform the tasks associated with each role. The system level security requirements also call for certain limitations on these privileges. Below is the procedure to assign JMPS roles with the required right/privilege in the JMPS domain.

· On the domain controller, log in as the administrator 

· Click on the Start menu, go to Settings, select Control Panel.

· Double-click on Administrative Tools.

· Double-click on Domain Security Policy

· Expand Local Policies

· Select User Rights Assignments

· Double-click each Policy item on the right panel

· Change the settings as stated in Trusted Facility Manual for the section on Command System Call & Function Definitions 

· Repeat the setting change of each policy   

· Right-click on Security Settings and select Reload.

· Close the Domain Security Policy window.

· Close the Administrative Tools window.

· Restart the machine.

10. Security Lockdowns, DACL (Discretionary Access Control List):  During the installation, if Apply Security Lockdowns was selected, permissions were set on JMPS directories.  One of the groups given permissions is “Authenticated Users.  To test in an Operational (Locked-Downed) environment, the file permissions must be manually reset to remove access for Authenticated Users and provide access for the appropriate JMPS groups.  See the Trusted Facility Manual for the section on Controlling Data and File Access in the Trusted Facility Manual (TFM) (JV1-448-01002, JMPS Version 1.0, Appendix L - TFM Final, 21 June 2002).

7 Detailed Instructions

The following sections provide more detailed instructions for selected steps listed above.

7.1 Installing JMPS Version JC1/JCP

You will first install the JMPS program and then the JMPS data.  If you are installing from CD and get an error message saying Error Cannot find Data.cab, then copy the install file to your hard disk and install from the hard drive (some machines have a security feature restricting the install from CD, usually COE).  JMPS will also install MSDE 2000 with SP3 if a version of MSDE is not already installed.  If you have an earlier version of MSDE, please uninstall it and JC1/JCP will reinstall it automatically.  If you have a version named machinename/JMPS_SQL_Server already installed, then JMPS will use it.  

Please note that there is a problem if you need to uninstall MSDE 2000 SP3.  The database files are not removed during uninstall.   If you ever need to uninstall the MSDE 2000 SP3, then you will need to delete the files in the following folder before you reinstall MSDE 2000 SP3: $DataDir\MSSQL$JMPS_SQL_SERVER\Data\.  These files should only be deleted after you have uninstalled MSDE 2000 SP3 (JMPS_SQL_SERVER) because they are MSDE's system database files!  If you do not delete these files, the JC1 install will fail during the install of MSDE.

After installing, on COE machines, you will install the two abbreviated JMPS segments using the COE installer.  This puts segment information on COE machines as well as updates COE lockdown settings.  These updates include: Allow the JMPS Users to run MMC and see the Event Viewer logs, Allow JMPS users to schedule tasks in the Task Scheduler (GPS Almanac Auto Update), Modify permissions on JMPS files and directories.  

Table 7‑1 Installing JMPS

	Step
	What You Do
	Installation Screen

	1 
	Navigate to the JC1/JCP Install directory on your hard drive, Build JC1/JCP-buildno.  Double click on the JMPS directory.  Double click on Setup.exe to launch the install.  (If you are installing from a CD, copy the JC1/JCP Install directory to your hard drive first.  If you are downloading from the WEB, download and un-PGP the file using the PGP pass phrase supplied via e-mail and then un-zip it).
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	2 
	On the JMPS Combat 1 Setup screen, click Next.  (This first part, installs the program files, latter you will install the data).
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	3 
	On the License Agreement screen, select the I accept the terms in the license agreement radio button and click Next (if you accept the terms).
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	4 
	On the Client vs. Server screen, select the Client radio button, if you are installing on a client.

Select the Server radio button, if you are installing on a machine that will function as the JMPS data server.  Then click Next to continue with the install.
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	5 
	On the COE Security Settings screen, select the Yes radio button, if you want to apply the Security settings (Lockdowns).  They will not be removed during uninstall.  Select the No radio button if you do not want to apply the Security settings.  Then click Next to continue with the install.
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	6 
	On the Setup Type screen, click next to accept the default (Complete) setup.  This installs JC1 to the default directory (D:\Program Files\JMPS if a D hard drive exists otherwise C:\Program Files).  Or, check the Custom radio button and then click next to specify a custom directory. 
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	7 
	If you selected a Custom setup type, click the Change button, to select a different location to install JC1 to. Select/deselect the features you want.  You may choose to deselect flight performance modules that you will not need. 
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	8 
	On the Ready to Install the Program screen, click Install, if you are ready to install.  Otherwise, click back to change any of your selections.  Click Cancel, if you want to abort the Install.
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	9 
	The Installing JMPS_Combat1 screen shows the status of the install process for the JC1 Program.  A second screen will appear showing the progress of remaining Combat1 program features.
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	10 
	When the program portion of the install completes, click Finish.
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	11 
	Once the JC1 Program install completes, the JC1 Data Install starts automatically.  On the JC1 Data Install screen, click Next to proceed with the Data Install.
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	12 
	On the Setup Type screen, Click Next to accept the default Data Install location (E:\Data\local\JMPS\data\if the E hard drive exits, otherwise C:\Data\local\JMPS\data\), or select the Custom radio button and then click Next, to specify a different install location.  (Skip to step 14 if you chose Complete.)
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	13 
	If you selected Custom setup type from the previous screen you will see the Custom Setup screen.  Select Change on the Custom Setup screen to specify a new install location.  Then click Next. 
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	14 
	On the Change Current Destination Folder screen, if you wish to change the destination folder, navigate to the new folder and click OK.  
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	15 
	On the Ready to Install the Program screen, click Install to proceed with the Data Install, click Back to change any of your settings, or click Cancel to abort the Data Install.
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	16 
	If you selected the install button, you will see a status window for the Data Install.  A second screen will appear showing the progress of remaining Combat1 data features, including the progress of extracting the Climatology data.  (This takes 5 + minutes).  After the data is installed, if you do not have MSDE installed as the JMPS_SQL_Server, then the install will install it.  If a dialog(s) titled Digital Signature Not Found is displayed, then click continue with the install.  This may display up to six times and is associated with COE lockdowns.
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	17 
	When the Data is installed and the Climatology data has been extracted the Completing the JMPS-Combat1-data-Setup wizard screen appears.  Click Finish.  JMPS MSI is now installed.  Next install the COE JMPS segments, if you are on a COE machine.
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On COE machines, install the two JMPS abbreviated segments – JMPS-Framework and JMPS-Framework-Data Segment. (This is currently optional and will puts segment information on COE machines as well as updates COE lockdown settings.  These updates include: Allow the JMPS Users to run MMC and see the Event Viewer logs, Allow JMPS users to schedule tasks in the Task Scheduler (GPS Almanac Auto Update), Modify permissions on JMPS files and directories.  To install the segments:

· Click on the Start menu, go to Programs, DII Applications, SysAdm, and select Segment Installer.

· Enter “the COE installer password” for the password (if it asks for a password).

· Click on the File menu and select Select Source drive.

· Select the location of the segment files (usually JC1 <build no>\JC1\JMPS Segments, or JC1\JMPS Segments), then click OK.

· Click on the File menu and select Read Table of Contents.

· Check the JMPS-Framework and JMPS-Framework-Data segments.

· Click on the Available Software menu and select Install.

· Restart the machine after the install is finished.

7.2 Install and Configure the FTP Server

This procedure should be performed only on the hosts that will act as JMPS PTW servers. Typically, this will be only the JMPS server.

Make sure your Windows OS disk(s) is available before starting this procedure.

7.2.1 Install the FTP Server

Table 7‑2 Installing the FTP Server

	Step
	What You Do
	Installation Screen

	1 
	Start\Settings\Control Panel

Click Add/Remove Programs

Click Add/Remove Windows components

Select Internet Information Services (IIS)

Click Details…
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	2 
	Select File Transfer Protocol (FTP) Server. This selects Common Files and Internet Information Services Snap-In

Click OK

Click Next

The system may ask you to insert your Windows OS disk.  Do so

Click OK
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7.2.2 Configure the FTP Server

Table 7‑3 Configuring the FTP Server

	Step
	What You Do
	Installation Screen

	1 
	Click Start\Run…

Enter mmc, and press return or click OK.
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	2 
	On the Microsoft Management Console window’s main menu select Console\Add/Remove Snap-In… from the Console drop down menu.
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	3 
	On the Add/Remove Snap-In dialog, click the Add… button
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	4 
	On the Add Standalone Snap-In, select Internet Information Services by double clicking, or single clicking and then clicking the Add button

Click the Close button.
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	5 
	On the Add/Remove Snap-In dialog, click the OK button.
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	6 
	Using the Console Root window, browse to the Default FTP Site entry. You may need to click on your local machine name entry before the Default FTP Site entry will appear.
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	7 
	Right-click the Default FTP Site entry and select Properties. 

On the FTP Site tab, change the Description to PTW FTP Site.
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	8 
	On the Security Accounts tab, check the Allow Anonymous Connections check box. PTW uses anonymous FTP to send the requested products back to the JMPS PTW server.
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	9 
	On the Home Directory tab, set the Local Path in the FTP Site Directory text box to a folder on the local system that has sufficient space to handle PTW imagery.  Check the Read, Write, and Log visits checkboxes.

Remember the Local Path setting for the FTP server. This path must be used as the value for the Push Path when configuring the JMPS PTW Server.

On the Default FTP Site Properties, click the OK button.
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	10 
	On the Console window, select Console\Exit.

If you click No, when asked whether to save console settings, you will need to reload the Internet Information Services Snap-In each time you run MMC. If you click Yes, when asked whether to save console settings, the console settings will be saved on the Desktop with a default name. Select Cancel when asked whether to save console settings if you want to save the settings somewhere else, or with a different name. Then, on the Console window, select Console\Save As…
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7.3 Configuring JMPSAdministrator Email Notification Upon Specific JMPS Errors

Components within JMPS have the ability to notify a JMPS Administrator when certain errors occur.  In order to receive these notifications, you must set a registry entry on your workstation specifying the email address of the JMPS Administrator.  The registry entry is:

   HIVE:
HKEY_LOCAL_MACHINE\Software\JMPS

   Key: 

AlertAdminEmailAddress

   Type:
String

   Value:
E-mail address of JMPS Administrator.

Table 7‑4 Configuring Email Notification

	Step
	What You Do
	Installation Screen

	1 
	As a Windows administrator select the Start menu and then the Run… option to bring up a Run dialog.

Enter regedit in the text box and select the OK option to bring up the Registry Editor.
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	2 
	Within the Registry Editor, navigate down to MyComputer\HKEY_LOCAL_MACHINE\SOFTWARE\JMPS.
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	3 
	If a key with the name of "AlertAdminEmailAddress” already exists, then proceed to step 5.

Otherwise, right mouse select the JMPS key (folder) and select New->String Value from the context menu.  This will create a new string value with the name “New Value #1”.
	
[image: image33.png]=1t

Begstry Edi View Favorites Hep

EL=] - Name [Type | Data
& Collapse | 381 Myafa it REG_SZ  (value not set)
a Key fleName  REG_SZ  jacobrod
@ End REG_SZ  data\configuration.mdb
Y= L REG_SZ  Betas
o e By eV REGSZ  cicombativersion T\datalo
a Rename DWORD Value REG_SZ  Sept 12, 2002
Eb]FrameworkDebLgzz REG_SZ
J (28] 3mpsDir REG_SZ  C:\Combat1iversion 1MPS
E"]MsdeLog\nName REG_SZ  BUILTIN\Users
{3 RouteObject: [E)visdeMsiFileame REG_SZ  SQLRUNIO.Mmsi
0 symbology 28R equiredviewBytes REG_SZ 75000000
{33 LANovation E”]SQLServerName REG_SZ  DLCA7-JACOBRO4VIMPS_SQL
{2 Mcafee [28]UsersDir REG_SZ  CUSERS
23 MicroQuill (28] version REG_SZ  (Version 1.0.1.1225)
0 Microsoft |

My Compuiter\HKEY_LOCAL_MACHINE\SOFTWARE\IMPS 4






	4 
	While this text is highlighted, rename it by typing AlertAdminEmailAddress and then tapping the Enter key.  This will create an AlertAdminEmailAddress value under JMPS.
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	5 
	Right mouse select AlertAdminEmailAddress and select the Modify option to bring up the Edit String dialog.
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	6 
	Enter the email address of the JMPS Administrator.  You may enter multiple e-mail address by separating them with semicolons.  Click the OK button to close the Edit String dialog.
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	7 
	Close the Registry Editor by selecting the close (X) icon in the upper right corner of the Registry Editor dialog.
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7.4 Installing Microsoft Message Queue

Microsoft Message Queue (MSMQ) enables applications to communicate with each other via messages.  These messages are sent into a queue, to be processed by receiving applications.  MSMQ is required to be installed prior to installing JC1 or the JC1 install will fail.

Table 7‑5 Installing Microsoft Message Queue

	Step
	What You Do
	Installation Screen

	1 
	Select the Windows Start button and navigate to the “Settings/Control Panel” option.  Select Add/Remove Programs.
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	2 
	From the Add/Remove Programs dialog, select Add/Remove Windows Components from the left hand side.
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	3 
	From the Windows Components Wizard dialog, select Message Queuing Services and press Next.
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	4 
	From the Message Queuing Type dialog, select Independent client and do not check the Manually select access mode to Active Directory check box. Then press Next.
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	5 
	From the Message Queuing Server dialog, select the Message Queuing will not access a directory service option and press Next.
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	6 
	If the installation process requests source media, insert your Windows 2000 Professional CD, select OK, and follow the on-screen prompts.  Or see step 7.
	[image: image43.png]clck OK. e

You can also click OK i you want fles o be copied
fiom an altemate location, such as a floppy disk or a
netuork server.






	7 
	Optionally, browse to the location where the Windows 2K install is stored. The files cand be found in the I386 directory.  Then select OK.
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	8 
	When the installation is complete, select Finish.
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	9 
	To use MSMQ you will have to restart your computer.
	


7.5   Configure Active Directory

Active Directory Tools required:

9. Active Directory Schema Management Snap-in:  

10. ADSI Edit tool:  The ADSI Edit tool is another snap-in for MMC that allows you to browse the directory partitions easily and retrieve attribute-level information from objects.  This tool is installed with the Windows 2000 Support Tools (Support\Tools\Setup.exe) on the Windows 2000 Server or Windows 2000 Advanced Server CD-ROM.

There are 3 methods of expanding your Schema:

11. Manually using the Active Directory Schema snap-in

12. Manually using import files

13. Programmatically using an installation program

Since we will be adding only a few attributes, we shall use the first method (Manually using the Active Directory Schema snap-in).  We will be adding 2 custom attributes to the schema.

7.5.1 Add Custom Attributes to Schema

14. First Locate the Schema Master for the Forest. If you are not sure who it is, then you can use netdom.exe from the Resource kit.

C:\WIN2K\system32>netdom query fsmo

Schema owner                
win2k.crisco.com

Domain role owner           
win2k.crisco.com

PDC role                    

win2k.crisco.com

RID pool manager            
win2k.crisco.com

Infrastructure owner        
win2k.crisco.com

The command completed successfully.
15. Once you have logged into the console of the Schema Master, you need to register the Active Directory Schema tool from the command line run:

· Search for the location (folder) that contains schmmgmt.dll.  The file schmmgmt.dll usually is located at c:\WINNT\System32

· Type: cd c:\WINNT\System32

· Run: regsvr32 schmmgmt.dll

This will result in the following message: (see Figure 1)
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Figure 1. RegSvr32.

16. Now you can run the Active Directory Schema Snap-in. Click on start Run and type: schmmgmt.msc.  The Active Directory  Schema Snap-in dialog pops up. (see figure 3).

17. You need to ensure that the Schema can be modified on this Domain Controller by doing the following steps: 

· Right Click on Active Directory Schema and go to Operations Master…. 

· Then the Change Schema Master shows up (see figure 18).  Make sure to select the checkbox “The Schema may be modified on this Domain Controller.” (see figures 2 & 3 below) and click on OK button to close the dialog.
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Figure 2. Console1.
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Figure 3. Change Schema Master.

18. It is time to add 3 custom attributes:  On the Schema Management Snap-in dialog, Right click on Attributes and go to New -> Attribute.   You will get a warning that this operation cannot be undone (see figure 4), click Continue button to close the warning dialog and then a Create New Attribute dialog pops up (see figure 21):
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Figure 4. Schema Object Creation.

19. Now enter information (Common Name, LDAP Display Name, Unique X500 Object ID, Syntax) for the  3 new custom attributes: (MDBName, MDBUpload and Location)  (see figures 5 and 6 for examples of MCBName and MDBUpload). For values of Unique X5000, please see explanation in appendix A. 
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Figure 5. Create New Attribute.
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Figure 6. Create New Attribute.

20. You must now associate the 3 new custom attributes you just created, with the Computer Class.  From the Schema Management Snap-in dialog (see figure 7 & 8),

· Expand the Classes  column and right click on the Computer Class and click on Properties. 
· On Computer Properties dialog, click on the Attribute Tab.

· Click on the Add button.  The Select Schema Object dialog shows up.
· On the Select Schema Object dialog, locate the 1st  new custom attribute (mDBName) you wish to link to the Computer Class and then Click on OK.

· Repeat the previous step for the 2nd and 3rd new custom attributes (mDBUpload and Location).

· Once that is completed, 3 new custom attributes shall be seen in the Optional listbox of Computer Properties dialog.

· Click OK button on the Computer Properties dialog.

· Restart the machine.
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Figure 7. Select Schema Object
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Figure 8. Computer Properties

7.5.2 Enter values for the 3 custom attributes:

21. At the command prompt, type ADSIEdit.MSC.  You should see ADSIEdit come up.
22. Expand the Domain NC and locate a Computer Object (or create a new one in Active Directory Users and Computers).
23. Once you find a computer object, right click on it and go to Properties. You will see a window like the one below (see figure 9).

24. Click on the drop down window for “Select a Property to View”.
25. Locate the new attribute you just associated with Computers; in this case I call it MDBName.
26. Populate the Attribute with the value you desire.

· For instance, we install JMPS application at  STATION1-COE machine.  The following steps shows how to configure and enter new values for MDBName on the STATION1-COE machine.

· Now search for the path of the database file configuration.mdb on this machine.  Usually, it is installed at: 

· c:\Program Files\JMPS\data\configuration.mdb.

· Make sure to share the directory c:\Program Files\JMPS\data\ and give permission to EveryOne as (Full Control=yes, Change=yes, Read=yes)

· Now enter the value :\\STATION1-COE\\data\\configuration.mdb into the Edit Attribute field. (See figure 9)

· Next, click on the Set button and you are done.

27. Locate the second new attribute you just associated with Computers, MDBUpload.

28. Populate the Edit Attribute for MDBUpload.

· Create a directory Upload as followed c:\Program Files\JMPS\data\Upload on STATION-COE machine.

· Now enter the value: :\\STATION1-COE\\data\\Upload\\ (See figure 10)

· Next, click on the Set button and you are done.

29. Locate the third new attribute you just associated with Computers, Location.

30. Populate the Edit Attribute for Location.

· Determine a string which best describes the location of the JMPS Server.  For example, “Second Floor, Room 222, East Bay”

· Now enter the value: Second Floor, Room 222, East Bay

· Next, click on the Set button and you are done.
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Figure 9. Station COE Properties
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Figure 10. Station COE Properties

7.6 Setup GCCS-M/I3 DAL

A JMPS client can be configured so that it can communicate with GCCS-M/I3 DAL to import Order of Battle data. Perform the following to setup the JMPS connection to the GCCS-M/I3 DAL:

1. Gather the following information from the GCCS-M/I3 DAL System Administrator: 

· DAL Domain Name, IP Address, Port Number, Username and Password

2. Install Trusted Root Certificate on client machine

· Get Trusted Root Certificate from GCCS-M/I3 DAL System Administrator

· Install the certificate on the client machine

3. Add the following inside of the $WINNT/system32/drivers/etc/hosts file

· appserver  IPAddress

Replace “IPAddress” with the IP Address that was collected above

· Note: This is to get around a bug in GCCS-M/I3 DAL Build 10. This is not necessary in Build 11.

4. Set storage of DAL Username and Password on remote server machine (optional)

· Select Options ( Preferences ( Password Server (optional)

Select a Username/Password Host (optional)

5. Set the Order of Battle Import Preference

· Select Options ( Preferences ( Order of Battle Import

Select “Connect to MIDB”

Enter DAL Domain Name, Port Number, Username and Password

6. Initiate Order of Battle Import

· Select File ( Import ( Order of Battle…

Trouble shooting JMPS connection to GCCS-M/I3 DAL:

1. Determine if we can access DAL file via HTTPS

· Within address field of Internet Explorer, enter the following:

https://DAL.domain.name.com/ishop/webservice/wsdl/SearchWebService.wsdl
Replace “DAL.domain.name.com” with real DAL Domain Name

· If the wsdl file is not downloaded to the browser, then:

Verify DAL Domain Name is correct

Verify that connectivity to DAL machine is good

Verify that Trusted Root Certificate was installed

“appserver” alias was added to “hosts” file

2. Determine if the DAL Username and Password are valid

· Within address field of Internet Explorer, enter the following:
https://DAL.domain.name.com/ishop/
· Within the Intel Shop page, click on Sign-In

· Within the Sign-In page:

Enter the DAL User Name and Password

Click the Sign-In button

· The DAL Username and Password is valid if you successfully get pass the Sign-In page

· Click on Sign-Out to log out of Intel Ishop

8 Trouble Shooting

1. If JC1 or JMPS has been loaded on the machine before and JC1 does not come up after you complete the above steps, you may have to delete some preference data. 

· Navigate to Documents and Settings\your user name\Application Data\JMPS and delete everything in this folder.

· Navigate to the data folder where you installed JMPS, to the \data\local\JMPS\data\Map_Data_Manager and delete everything in this folder. This will delete your maps. If you want to save old map data, you can try renaming the directory, running JC1 and then copying selected map data one at a time into the newly created folder.

2. If you get an error message saying you do not have permissions to run JMPS, then you have not set up the JMPS Security Roles.  
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Figure 11. Security Check Failed.

3. If, while you are attaching databases in the MSDE, you get the following message:
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Figure 12. Attachable Database Error.

Then delete the DAFIF log file (or the appropriate log file in the appropriate directory).  It is located in the directory you installed your data to, under DAFIF\DAFIF_log.LDF.  For instance C:\data\local\JMPS\data\DAFIF\DAFIF_log.LDF.

4. If, while you are attaching databases in the MSDE, you get the following message:
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Figure 13. Attachable Database Error.

You may disregard this error message as long as all of the databases (Aimpoints, DAFIF, JTIDS, LocalPoints, MissionBinder, OrderOfBattle, PointExtract, and ThreatParameters) were attached.  If one of these databases was not attached, this may also be a database log problem.  Identify which database was not attached and navigate to the dataInstallDir\data\local\jmps\data\databasename and delete the databasename_log.ldf file. Then reattach the database using MSDE.

5. If, while starting JC1, you get a message saying the Windows Security Log is Full, then you have not set the Event Viewer log files to overwrite as necessary. (See section 4 - Pre Setup).

[image: image57.png]° A signficent secutirty error has occured. JMPS can ot continue,

Plesse contact your JMP5 Securiy Administrator or further detais and insructions.

Repart the Fallawing problem:
Windows Securty Log i Ful - St to averwrite or clar log





Figure 14. JMPS Security Error Dialog

6. If you are not running on a COE machine and while starting JC1, you get the following message or the following empty JMPS window:
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Figure 15. DII-COE Classification Error Dialog
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Figure 16. Empty JMPS Window
Then you have not registered the JMPSSecurityUtilitiesStub.dll  This is available on the China Lake site under UPC Devlopers/ToolsTestbed/Developer Security and Privilege stubs.  

7. If, while starting JMPS, you get the following error message:
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Figure 17.  COM Exception caught in Configuration Manager

Then the JMPSPublisher Service has not started correctly.  To start the JMPSPublisher service:

· Right click on My Computer and select manage.
· Expand the Services and Applications tree.
· Select Services in the right window.
· Right click on the JMPSPublisher service and select properties.
· On the General tab, change the Startup type to Automatic.
· Select the Recovery tab and in the First failure and Second failure drop down boxes select Restart the Service.
· Select the Log On tab (If the machine is a JMPS Server).
· Select the This account radio button.
· Browse to an admin account and provide the appropriate password.
· Click OK.
· Right click on the JMPSPublisher service and select restart. 

8. The MissionBinder components have been changed so that MissionBinders runs in its own process as a COM + Component.  There is a new COM + component that gets installed - MissionBinderRepository.  If when running MissionBinders you encounter an error, you may not be able to run MissionBinders again until you shut down the MissionBinderRepository COM + event. If you get the following error message:
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Figure 18. Invalid Data Source Error

· Exit JMPS 

· Navigate to the Start/Settings/Control Panel/Administrative Tools/Component Services dialog.  

· Expand the Component Services tree. 

·  Expand the Computers tree.  

· Expand the My Computer tree.  

· Expand the COM+ Applications tree.  

· Right click on the MissionBinderRepository entry and select Shut Down.

Appendix A:
OIDs and what are they : 
 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/netdir/ad/object_identifiers.asp
 

Object Identifiers (OIDs) are unique numeric values, issued by various "Issuing Authorities" to uniquely identify data elements, syntaxes, and various other parts of distributed applications. OIDs are found in OSI applications, X.500 Directories, SNMP, and other applications where uniqueness is important. OIDs are based on a tree structure, in which a superior issuing authority (such as the ISO) allocates a "branch" of the tree to a subauthority, who in turn can allocate subbranches.

  

Get an OID from Microsoft Corporation:
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/netdir/ad/obtaining_an_object_identifier_from_microsoft.asp
 

Object Identifiers (OIDs) can be obtained from, and registered with Microsoft by going to the following URL:

 

http://msdn.microsoft.com/certification/ad-registration.asp
 

Click on "please register now". On the Registration page, read the instructions, and then fill out the form for registering your OID. If you want Microsoft to generate the OID for you, simply leave blank that entry on the form.

 

No matter what source is used to get the OID, if you intend to extend the Active Directory schema and wish to apply for the Certified for Windows logo, you must register your OID with Microsoft. 

 

If a base OID is obtained, some care should be used in designing how the OIDs should be divided into categories, since these OIDs are contained in the prefix table and are part of the DC replication data. It is recommended that no more than two OID categories be created.

 

For example, if you were assigned the base OID of 1.2.840.113556.1.8000.586, you might create categories in the following manner:

 

a) For Application Attributes:

1.2.840.113556.1.8000.586.1.1
(for 1st custom attribute)

1.2.840.113556.1.8000.586.1.2
(for 2nd
custom attribute)

1.2.840.113556.1.8000.586.1.3
(for 3rd custom attribute)

and so on….




b) For Application Classes:

1.2.840.113556.1.8000.586.2.1
(for 1st custom class)

1.2.840.113556.1.8000.586.2.2
(for 2nd custom class)

1.2.840.113556.1.8000.586.2.3
(for 3rd custom class)

and so on…

Something you may want to consider, is to replicate these attributes in the Global Catalog, or to Index them. Both of these actions come at a cost, but improve the search performance for often accessed attributes. If you right click on the attribute you just created you will see these options made available to you.









�PAGE \# "'Page: '#'�'"  �� As of last build, after selecting default, install shield  may pick a wrong drive to install to. Is this fixed? If not, wording should be different than the original.


�PAGE \# "'Page: '#'�'"  �� Move to last of security lockdowns. This is the sequence we apply and test currently.


�PAGE \# "'Page: '#'�'"  �� This is not addressed in the latest TFM. This is the place the  installers see it for the first time.
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